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Introducing Expression Design
 Microsoft Expression Design is a professional design tool used to create vector 

and bitmap illustrations and elements for desktop publishing, print, and the Web. 

Traditional shape tools and drawing tools—such as the Pen, Polyline, and B-Spline 

tools—give the artist or illustrator everything necessary for dramatic and creative 

illustrations. By using skeletal strokes to provide the utmost in editing power, brush 

strokes are placed along vector paths, keeping the strokes fully editable, even one 

anchor point at a time, for total control and precision. Brush strokes can emulate 

artistic media like watercolors and acrylics for unique capabilities in a vector illustra-

tion program. 

 Expression Design is part of Microsoft Expression Studio, which is an integrated group 

of applications that, in addition to Expression Design, includes the following: 

 Expression Blend. A professional design tool used to create engaging, Web-con-

nected multimedia experiences for Windows. 

 Expression Web. A professional design tool used to create modern, standards-

based sites that deliver superior quality on the Web. 

 Expression Media. A professional asset management tool for visually cataloging 

and organizing all your digital assets, and that provides for effortless retrieval and 

presentation. 

 Today’s graphic designers work in a variety of media, and the ability to use one suite of 

integrated products to provide clients with designs for print, the Web, and animation is 

a great time saver. Microsoft Expression Studio provides the tools and the power to work 

for all types of output in one package. 



This page intentionally left blank 
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Information for Readers Running 
Windows XP

 The graphics and operating system–related instructions in this book refl ect the Windows 

Vista user interface. However, Windows Vista is not required; you can also use a computer 

running Windows XP with Service Pack 2 (SP2) installed. 

 Most of the differences you will encounter when working through the exercises in this 

book on a computer running Windows XP relate to appearance rather than functional-

ity. For example, the Windows Vista Start button is round rather than rectangular and 

is not labeled with the word Start; window frames and window-management buttons 

look different; and if your system supports Windows Aero, the window frames might 

be transparent. 

 In this section, we provide steps for navigating to or through menus and dialog boxes in 

Windows XP that differ from those provided in the exercises in this book. For the most 

part, these differences are small enough that you will have no diffi culty in completing 

the exercises. 

Managing the Practice Files
 The instructions given in the “Using the Book’s CD” section are specifi c to Windows 

Vista. The only differences when installing, using, uninstalling, and removing the 

practice fi les supplied on the companion CD are the default installation location 

and the uninstall process. 

 On a computer running Windows Vista, the default installation location of the 

practice fi les is Documents\Microsoft Press\Expression Design SBS. On a computer 

running Windows XP, the default installation location is My Documents\Microsoft 
Press\Expression Design SBS. If your computer is running Windows XP, whenever 

an exercise tells you to navigate to your Documents folder, you should instead go 

to your My Documents folder. 



x  Information for Readers Running Windows XP

 To uninstall the practice fi les from a computer running Windows XP: 

  1. On the Windows taskbar, click the Start button, and then click Control Panel. 

  2. In Control Panel, click (or in Classic view, double-click) Add or Remove Programs. 

  3. In the Add or Remove Programs window, click Microsoft Expression Design Step 
by Step, and then click Remove. 

  4. In the Add or Remove Programs message box asking you to confi rm the deletion, 

click Yes. 

Using the Start Menu
 Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 

Start menu expand horizontally. However, the steps to access a command on the Start 

menu are identical on both systems. 

 To start Microsoft Expression Design on a computer running Windows XP: 

 Click the Start button, point to All Programs, click Microsoft Expression, and then 

click Microsoft Expression Design. 

Navigating Dialog Boxes
 On a computer running Windows XP, some of the dialog boxes you will work with in 

the exercises not only look different from the graphics shown in this book but also work 

differently. These dialog boxes are primarily those that act as an interface between 

Expression Design and the operating system, including any dialog box in which you 

navigate to a specifi c location. 

 For example, to navigate to the My Pictures folder in Windows XP: 

 On the Start menu, click My Pictures. 

 To move back to the My Documents folder in Windows XP: 

 On the toolbar, click the Up One Level button. 

Up One LevelUp One Level
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Features and Conventions of 
This Book

 This book has been designed to lead you step by step through all the tasks you are 

most likely to want to perform in Microsoft Expression Design. If you start at the be-

ginning and work your way through all the exercises, you will gain enough profi ciency 

to be able to create complex illustrations by using vector and bitmap tools. However, 

each topic is also self contained. If you have worked with another graphic design 

program, or if you completed all the exercises and later need help remembering 

how to perform a procedure, the following features of this book will help you locate 

specifi c information: 

 Detailed table of contents. Scan this listing of the topics and sidebars within 

each chapter to quickly fi nd the information you want. 

 Chapter thumb tabs. Easily locate the beginning of the chapter you want. 

 Topic-specifi c running heads. Within a chapter, quickly locate the topic you 

want by looking at the running head of odd-numbered pages. 

 Detailed index. Look up specifi c tasks and features and general concepts in the 

index, which has been carefully crafted with the reader in mind. 

 Companion CD. Install the practice fi les needed for the step-by-step exercises, 

and consult a fully searchable electronic version of this book and other useful 

resources contained on this CD. 

 In addition, we provide a glossary of terms for those times when you need to look up 

the meaning of a word or the defi nition of a concept. 

 You can save time when you use this book by understanding how the Step by Step series 

shows special instructions, keys to press, buttons to click, and so on. 



xii  Features and Conventions of This Book

 Convention Meaning

 

This icon indicates a reference to the book’s companion CD.

 USE This paragraph preceding a step-by-step exercise indicates the practice 
fi les or programs that you will use when working through the exercise.

 BE SURE TO This paragraph preceding or following a step-by-step exercise indicates 
any requirements you should attend to before beginning the exercise 
or actions you should take to restore your system after completing the 
exercise.

 OPEN This paragraph preceding a step-by-step exercise indicates fi les that 
you should open before beginning the exercise.

 CLOSE Large numbered steps guide you through hands-on exercises in 
each topic.

 1

2

Large numbered steps guide you through hands-on exercises in 
each topic.

 1

2

Small numbered steps guide you through procedures in sidebars and 
in expository text.

An arrow indicates a procedure that has only one step.

 Tip These paragraphs give you a helpful hint or shortcut that makes work-
ing through a task easier, or information about other available options.

 Important These paragraphs point out information that you need to know to 
complete a procedure.

 Troubleshooting These paragraphs warn you of potential missteps that might prevent 
you from continuing with the exercise.

 See Also These paragraphs direct you to more information about a given topic 
in this book or elsewhere.

 F In step-by-step exercises, keys you must press appear as they would 
on a keyboard.

 H+D A plus sign (+) between two key names means that you must hold 
down the fi rst key while you press the second key. For example, “Press 

H+D” means “hold down the H key while you press the D key.”

 Program interface 
elements and user 
input

In steps, the names of program elements (such as buttons, commands, 
and dialog boxes) and text that you are supposed to type are shown 
in bold characters.

 Glossary terms Terms explained in the glossary are shown in bold italic characters.

 Paths and 
emphasized words

Folder paths, URLs, and emphasized words are shown in italic 
characters.
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Using the Book’s CD
The CD inside the back cover of this book contains the practice fi les you’ll use as you 

work through the exercises in this book. By using practice fi les, you can jump right in and 

concentrate on learning how to get the most of out of Microsoft Expression Design.

CD Contents
The following table lists the practice fi les necessary to complete the exercises.

 Chapter Practice fi les

Chapter 1:
Working with Documents

WorkingDocuments\pear.design

WorkingDocuments\tree.design

Chapter 2:
Navigating the Workspace

NavigatingWorkspace\pear.design

NavigatingWorkspace\tree.design

Chapter 3:
Manipulating Objects

ManipulatingObjects\hearts.design

ManipulatingObjects\objects.design

Chapter 4:
Working with Layers

UnderstandingLayers\layers.design

Chapter 5:
Using the Drawing Tools

UsingDrawingTools\B-Spline1.design

UsingDrawingTools\B-Spline2.design

UsingDrawingTools\clipping_paths.design

UsingDrawingTools\compound_paths.design

UsingDrawingTools\path_operations.design

UsingDrawingTools\pentool.design

UsingDrawingTools\polyline1.design

UsingDrawingTools\polyline2.design

Chapter 6:
Using Fills

UsingFills\heart.design

UsingFills\my_rose.design

UsingFills\paintbrush.design

UsingFills\pattern.bmp

UsingFills\properties_panel.design

continued

The CD that accompanies the print edition of this book is not available with this eBook edition, although select
CD content is available for download at http://go.microsoft.com/fwlink/?LinkId=108470.

http://go.microsoft.com/fwlink/?LinkId=108470
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 Chapter Practice fi les

Chapter 7:
Using Strokes

UsingStrokes\blends.design

UsingStrokes\hand.design

UsingStrokes\my_heart.design

UsingStrokes\paths_and_clones.design

UsingStrokes\redrose.png

UsingStrokes\save_stroke.design

Chapter 8:
Working with Text

WorkingText\abc.design

WorkingText\barchart.design

WorkingText\ransom.design

WorkingText\smile.design

WorkingText\smile_dot.design

WorkingText\valentine.design

WorkingText\wordballoon.design

Chapter 9:
Working with Bitmap 
Images

WorkingBitmaps\berries.bmp

WorkingBitmaps\ghost.design

WorkingBitmaps\leaves.bmp

WorkingBitmaps\pumpkin.design

WorkingBitmaps\trickortreat.design

Chapter 10:
Exporting and Printing 
Your Work

ExportingWork\dragon.design

ExportingWork\keyboard.design

ExportingWork\knight.design

ExportingWork\lamp_squirrel.design

ExportingWork\phrenology.design

ExportingWork\water.design

In addition to the practice fi les, the CD also includes exciting resources that will enhance 

your ability to get the most out of using this book and Expression Design, including an 

electronic version of the book in PDF format.

Minimum System Requirements
To use this book, your computer should meet the following requirements:

 Processor. Pentium 700 megahertz (MHz) or higher; 2 gigahertz (GHz) 

recommended.

 Memory. 512 megabytes (MB) of RAM; 1 gigabyte (GB) or more recommended.
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 Hard disk. For the eBooks and downloads, we recommend 3 GB of available hard 

disk space with 2 GB on the hard disk where the operating system is installed.

 Operating system. Windows Vista or later, Windows XP with Service Pack 2 (SP2), 

or Windows Server 2003 with Service Pack 1 (SP1) or later.

 Drive. CD or DVD drive.

 Display. Monitor with 1024x768 or higher screen resolution and 16-bit or higher 

color depth.

 Software. Microsoft Expression Design.

Tip Actual requirements and product functionality may vary based on your system confi gu-
ration and operating system.

Installing the Practice Files
You must install the practice fi les on your hard disk before you can use them in the 

chapters’ exercises. Follow these steps to prepare the CD’s fi les for your use.

Important Installing the practice fi les requires the privileges of a local system administrator.

To install the fi les from the CD:

 1. Remove the companion CD from the envelope at the back of the book, and insert 

it into the CD drive of your computer.

The Step By Step Companion CD License Terms appear. Follow the on-screen 

directions. To use the practice fi les, you must accept the terms of the license 

agreement. After you accept the license agreement, a menu screen appears.

Important If the menu screen does not appear, click the Start button and then click 
Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 
drive, and then in the right pane, double-click the StartCD.exe fi le.

 2. Click Install Practice Files.

If you are installing the practice fi les on a computer running Windows Vista, a File 

Download – Security Warning dialog box opens.
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 3. Click Run, and when an Internet Explorer – Security dialog box opens, click Run.

The Microsoft Expression Design Step By Step dialog box opens.

 4. Click Next on the fi rst screen, click I accept the terms in the license agreement, 
and then click Next.

 5. If you want to install the practice fi les to a location other than the default folder 

(Documents\Microsoft Press\Expression Design SBS), click the Change button, 

select the new drive and path, and then click OK.

Important If you install the practice fi les to a location other than the default, you 
will need to substitute that path within the exercises.

 6. Click Next on the Choose Destination Location screen, and then click Install on 

the Ready to Install the Program screen to install the selected practice fi les. If a 

User Account dialog box opens stating that an unidentifi ed program wants to 

access your computer, click Allow.

 7. After the practice fi les have been installed, click Finish.

 8. Close the Step by Step Companion CD window, remove the companion CD from 

the CD drive, and return it to the envelope at the back of the book.

Using the Practice Files
When you install the practice fi les from the companion CD, the fi les are stored on your 

hard disk in chapter-specifi c subfolders under Documents\Microsoft Press\Expression 
Design SBS.

Wherever possible, each chapter is started with the default settings in Expression Design. 

To reset the workspace, click Reset Active Workspace on the Window menu. Then type 

D to set the stroke and fi ll to the default settings. Although you do not have to complete 

every chapter in order, some exercises make use of user-created fi les.

A Housekeeping segment at the beginning of each chapter explains any preparation you 

need to take before you start working through the chapter, as shown here:

Important Before you can use the practice fi les in this chapter, you need to install them 
from the book’s companion CD to their default location. See “Installing the Practice Files.”
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Each exercise within a chapter is preceded by a Housekeeping segment that lists the 

practice fi les needed for that exercise. The text also explains any preparation you need 

to take before you start working through the exercise, as shown here:

USE the tree.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\WorkingDocuments folder.

BE SURE TO start Expression Design before beginning this exercise.

OPEN the tree.design fi le.

You can browse to the practice fi les in Windows Explorer by following these steps:

 1. On the Windows taskbar, click the Start button, and then click Documents.

 2. In your Documents folder, double-click Microsoft Press, double-click Expression 
Design SBS, and then double-click a specifi c chapter folder. The folders are named 

to correspond to their respective chapters.

Removing the Practice Files
You can free up hard disk space by uninstalling the practice fi les that were installed 

from the companion CD. The uninstall process deletes any fi les that you created in the 

Documents\Microsoft Press\Expression Design SBS folder while working through the 

exercises.

Follow these steps:

 1. On the Windows taskbar, click the Start button, and then click Control Panel.

 2. Under Programs, click Uninstall a program.

 3. Click Microsoft Offi ce Expression Design Step by Step, and then click Uninstall.

 4. In the Programs And Features dialog box, click Yes.

 5. In the User Account Control dialog box, click Allow.

Important Microsoft Product Support Services does not provide support for this book or 
its companion CD.

USE the tree.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\WorkingDocuments folder.

BE SURE TO start Expression Design before beginning this exercise.

OPEN the tree.design fi le.

StartStart

StartStart
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Getting Help
 Every effort has been made to ensure the accuracy of this book and the contents of its 

CD. If you run into problems, please contact the appropriate source, listed in the follow-

ing sections, for assistance. 

Getting Help with This Book and Its CD
 If your question or issue concerns the content of this book or its companion CD, please 

fi rst search the online Microsoft Press Knowledge Base, which provides support informa-

tion for known errors in or corrections to this book, at the following Web site: 

www.microsoft.com/mspress/support/search.asp

 If you do not fi nd your answer in the online Knowledge Base, send your comments or 

questions to Microsoft Learning Technical Support at: 

mspinput@microsoft.com

Getting Help with Microsoft Expression Design
 If your question is about Microsoft Expression Design, and not about the content of this 

Microsoft Press book, help is available from the Help menu of Expression Design itself. 

Click Help, and then click User Guide or press F1. 

 If you need additional help, please search the Microsoft Help and Support Center or the 

Microsoft Knowledge Base at: 

support.microsoft.com

http://www.microsoft.com/mspress/support/search.asp
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 In the United States, Microsoft software product support issues not covered by the 

Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 

The Microsoft software support options available from Microsoft Product Support 

Services are listed at: 

www.microsoft.com/services/microsoftservices/srv_support.mspx

 Outside the United States, for support information specifi c to your location, please refer 

to the Worldwide Support menu on the Microsoft Help And Support Web site for the 

site specifi c to your country: 

support.microsoft.com/common/international.aspx

http://www.microsoft.com/services/microsoftservices/srv_support.mspx
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 4 Working with  Working with 
  Layers  Layers
In this chapter, you will learn to:

 Understand layers.

 Explore layers.

 Manipulate layers.

 Set layer options.

One of the best features of Microsoft Expression Design is its use of layers. Layers 

give you the fl exibility to design several versions of a document, decide what parts 

of a document will be printable, and much more. 

In this chapter, you will fi rst learn what layers are and why they are important. You will 

learn how to use the Layers panel to expand, collapse, add, delete, move, hide, and 

group layers. You will also learn to use the Layers panel to select groups of objects in 

one step. 

Important Before you can use the practice fi les in this chapter, you need to install them 
from the book’s companion CD to their default location. See “Using the Book’s CD” at the 
beginning of this book for more information. 

 Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book. 

Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.
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Understanding Layers: What They Are and 
Why They Are Important

The layers concept is one that is often very diffi cult for new users of graphics software to 

grasp. The truth is, once you understand the concept, you will be amazed that you were 

ever able to work without them. To cite one simple example, when you put an object on 

another layer, you can show or hide the object or make it non-printing. 

Using layers, you can easily hide and show whole layouts. One use for this technique is to 

create a two-sided document, such as a brochure or greeting card, and put all content 

for the front on one layer, and all content for the back on another layer. By showing one 

layer and hiding the other, you can work on (or print) the front or back independently, 

yet both layers are conveniently saved in one document. 

So what exactly are layers?  

In Expression Design, layers are like virtual stacks of transparent pages. These stacks 

function like the transparent plastic pages in some biology textbook illustrations. For 

instance, imagine an illustration of a hand, showing the skin. When you turn the skin 

page, an image of the muscles, blood vessels, and bone appears underneath. Flip the 

next page and the muscle page is transparent, showing the vessels and bone beneath, 

and so on. Layers are like those transparent pages: transparent areas of the layer let the 

lower layers remain visible. The areas on the layer that contain content hide whatever is 

on the layers below. 

Layers are accessible from the Layers panel. From this panel, layers can be manipulated, 

hidden, moved, grouped, and much more. 

In the Layers panel, layers are shown in the layers list. Layers are displayed in the Layers 

panel in the order in which their content is on the page; the top layer is at the top of the 

stacking order. Each layer has a small thumbnail of the layer content to the left of its name. 



In this exercise, you will explore the Layers panel and the layers in a fi le. You will fl oat 

the Layers panel in the workspace, and then display a magnifi ed thumbnail view of the 

layer’s contents.  

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

BE SURE TO start Expression Design before beginning this exercise.

 1. Open the layers.design fi le. 

In the image window, you should see blue sky and clouds. In the right pane of the 

workspace in the Layers panel, the layer thumbnail shows a small representation of 

the layer contents, in this case the blue sky and clouds.  

 2. Click the Float button to fl oat the panel in the workspace.  

You can now drag the panel in the workspace and place it where it is convenient. 

Whether you choose to fl oat the panel or leave it docked in the pane is a matter of 

personal preference. 

Tip If the Layers panel is not visible, click Layers on the Window menu to open it. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

BE SURE TO start Expression Design before beginning this exercise.

FloatFloat
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This image has four layers: sky, Layer 2, summer, and autumn. Sky is the bottom 

layer in the Layers panel, making it the bottom layer in the stacking order. When 

the layers are visible, the content in the Layer 2, summer, and autumn layers will 

show above the sky layer. 

 3. Point to the summer thumbnail. 

A larger pop-up thumbnail appears, showing the contents of the layer. 

Tip If the thumbnail does not pop up when you point to it, click the Layer Options 
button. Then, on the Layer Options menu, click Thumbnail Options, and click Popup 
Thumbnails. Note that you can also set the size of the layer thumbnail here. You can 
choose from Large, Medium, or Small, or you can turn layer thumbnails off altogether 
by choosing None. 

Exploring Layers
With the Layers panel, you have a lot of control over many aspects of your document. 

You can show and hide layers, add new layers, delete layers you no longer need, or re-

name the layers. You can also select a whole layer or specifi c objects on a layer so that 

you can easily group layers or to change the stacking order. 

Naming, Hiding, and Collapsing and Expanding Layers
A single document can have many layers, each with different properties and content. Every 

Expression Design document always contains at least one layer. When you create a new 

document, Expression Design automatically creates an empty layer. By default, this layer 

is named Layer 1. When you add new layers, they are named consecutively: Layer 2, Layer 
3, and so on. However, it is very helpful, especially in a document with many layers, to 

name the layers with meaningful names. 

A button on the right side of the Layers panel shows whether each layer is hidden or 

visible. When a layer is hidden, the button looks like a circle, and when a layer is visible, 

the button looks like an eyeball. For example, in the layers.design fi le, the sky layer dis-

plays the eyeball; the other three layers display the circle because they are hidden. 



Because Expression Design is a vector drawing program, most of its fi les have hundreds 

of objects. Each brush stroke you lay down, every shape you draw, every object added to 

the page is a separate object with its own sub-layer in the Layers panel. An image with 

many layers can make the Layers panel very long and hard to navigate. You can keep the 

panel manageable by collapsing and expanding it when you need to access an object on 

the layer. When layers are expanded, the object lists for each layer are visible, including 

groups. 

In this exercise, you will name layers in the Layers panel. Then you will hide and show 

layer content in the image window by using the Toggle Layer Visibility button in the 

Layers panel. You will also keep the size of the Layers panel manageable by collapsing 

and expanding layers. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

 1. In the Layers panel, double-click Layer 2, and replace the text with the word 

winter. 

 2. Press F to commit the change. Click Save on the File menu to save the changes 

to the fi le. 

 3. On the sky layer, click the Toggle Layer Visibility button. 

The image window is now blank because the sky layer is hidden. 

 4. Click the Toggle Layer Visibility button to make the sky layer visible again. 

 5. On the winter layer, click the Toggle Layer Visibility button to make it visible. 

Hidden layer

Visible layer

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

Visibility OnVisibility On

Visibility OffVisibility Off
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The image window now displays snow on the ground, a snowman, and a tree with 

bare branches from the winter layer, and sky and clouds from the sky layer. The area 

around the objects in the winter layer is transparent, allowing the objects in the sky 

layer to show through. 

 6. On the sky layer, click the Toggle Layer Visibility button. 

The sky and clouds disappear from the image window. 

 7. On the sky layer, click the Toggle Layer Visibility button to redisplay the layer. 

 8. On the summer layer, click the Toggle Layer Visibility button. 

The image window displays a green summer tree, some birds, and a patch of green 

grass. The rest of the summer layer is transparent. Because of the transparency, the 

sky and clouds from the sky layer and the snowman from the winter layer are also 

visible. 



 Tip You can toggle the visibility of all the layers except one by pressing Alt and 
clicking on the Toggle Layer Visibility button of the layer you want to keep visible. 

 9. In the Layers panel, in the list of layers, click the Expand button on the autumn 

layer to display the object list. 

The layer expands to show the object list for the layer, which consists of three 

groups: fallen leaves, tree, and ground. All three groups in this layer are collapsed.  

 10. Click the Expand button to the left of the ground group to expand the group and 

display its object list.  

 11. On the autumn layer, click the Collapse button to close the object list. 

BE SURE TO collapse all of the layers in the Layers panel before continuing to the next 
exercise.

ExpandExpand

CollapseCollapse

BE SURE TO collapse all of the layers in the Layers panel before continuing to the next 
exercise.
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Tip As you add paths and objects to a document, Expression Design gives them generic 
names, such as [5 points]. Consider naming important paths, groups, or objects to fi nd 
them quickly if you want to select them to be edited or moved to another layer. 

Selecting, Locking, and Grouping Layers
Layers cannot be selected if they are not visible, nor can they be selected if they are 

locked. When a layer is visible, a hollow square button displays to the right of the name. 

This button is used to select all unlocked content on a layer. 

You can lock and unlock layers by using the Toggle Lock buttons in the Layers panel. 

These buttons have two states, locked and unlocked, as indicated by the corresponding 

padlock images. Locking a layer works the same as locking an object, with the exception 

that when you lock a layer, the entire layer is locked and none of the objects on it can be 

edited or moved. When you lock a layer, it is protected from being changed by the acci-

dental move of an object on the page. It is also protected from global changes you make 

to the rest of the document. 

Hidden layers are always locked; unlocking a layer makes it visible. You can lock a visible 

layer, too, so that the objects on the locked layer are still visible but you cannot acciden-

tally move, delete, or alter the objects on it.  

Grouping similar objects and/or paths together often makes them much easier to work 

with. However, objects and paths can be diffi cult to select when there are many of them 

or they are behind other objects. To make this task easier, you can expand a layer in the 

Layers panel so the object list is displayed, and then press Shift while clicking the objects 

you want to select. You can then group the objects by clicking Group on the Arrange 

menu. To ungroup grouped objects, click Ungroup on the Arrange menu. Groups can be 

contained within each other. 

Grouping objects by using the Layers panel is often easier than selecting objects by click-

ing on them, because an object that is behind another can be diffi cult to select. Selecting 

via the Layers panel is also easier when you have many objects to select at once, as you 

will understand when you try to select all of the branches or leaves at once.  

In the following exercise, you will select layers and lock and unlock them by using the 

Layers panel. You will also group objects in the Layers panel to organize them and make 

diffi cult selections easier. 



USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

 1. Click the summer layer’s Toggle Layer Visibility button. 

The sky layer should be visible, and the autumn and winter layers hidden. 

 2. Click the Layer Selection button on the summer layer to select all content on the layer.  

Because there are no locked objects, all layer content will be selected. The square 

button turns solid blue, and you will be able to see the paths on all objects on the 

layer in the image window. In this case, the summer tree, leaves on the ground, 

and the birds are selected. 

 Tip When an object is low in the stacking order, it can be hard to select with the 
selection tools. If you click the object’s thumbnail or name in the Layers panel, you 
can easily select it. 

 3. Click the Toggle Layer Visibility button on the autumn and winter layers.  

Notice that the autumn and winter layers are locked and therefore cannot be se-

lected. The summer layer is unlocked and selected; the sky layer is unlocked and 

not selected. Because the sky layer is not locked, if you click the clouds or the sky 

background in the image, they would become selected, along with their layer. 

Tip You can hold the Alt key as you click a Lock button to lock all layers except the 
layer you clicked. If all of the other layers are currently locked, holding Alt as you click 
a Lock button unlocks them all. 

 4. Experiment with locking and unlocking layers to get a feel for how the feature 

works by clicking the Toggle Lock button for each of the layers. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

Visibility OffVisibility Off

Layer SelectionLayer Selection
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 5. Before continuing, click Revert on the File menu to return the fi le to the state from 

which it was last saved. 

This should leave the fi le in the same state it was in when you started this exercise. 

 6. Show the summer layer by clicking its Toggle Layer Visibility button. 

 7. In the Layers panel, expand the summer layer by clicking the Expand button. 

 8. Expand the tree group by clicking its Expand button. 

The tree group has three groups within it: leaves, branches, and trunk. The branches 

would be extremely diffi cult to select without the Layers panel, because many of 

them are behind leaves, but it is a simple matter to select all of them from the ob-

ject list. 

 9. In the tree group, select branches, and then on the Arrange menu, click Group. 

The leaves would be hard to select for the sheer number of them and the fact that 

they are intermingled with the small upper branches of the tree. Selecting groups 

of items from the object list greatly simplifi es this task. 

BE SURE TO click Revert on the File menu to return the document to the last saved state 
before continuing.

Manipulating Layers
Layers are even more useful in that you can arrange them to suit your purposes. Add 

them to your document window, delete them, reorder them, or move objects from one 

layer to another, all by way of simple, intuitive controls. 

Visibility OffVisibility Off

ExpandExpand

BE SURE TO click Revert on the File menu to return the document to the last saved state
before continuing.



Adding a New Layer
As you work in Expression Design, you will very often want to add new layers to your 

documents. Objects on their own layers are easy to hide and show, so you can try dif-

ferent versions of an illustration while retaining the original version, all within one fi le. 

In the layers.design fi le, a new layer was used to add autumn leaves on the tree while 

retaining the green summer leaves. 

Layers also give you the fl exibility to print only part of the design. One way this tech-

nique can be used is to design the front and back of a greeting card on separate layers. 

The back layer can be hidden so the front layer can be edited or printed, or you can 

hide the front layer to print or edit on the back. 

In this exercise, you will add a new layer to the document. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

 1. In the Layers panel, click the sky layer to select it.  

This can also be referred to as making it the active layer.  

 2. To add a new layer to the document, click the New Layer button at the bottom of 

the Layers panel. 

A new layer called Layer 5 displays directly above the sky layer. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

New LayerNew Layer
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 3. Select the Rectangle tool, and drag a rectangle of any size in the image window. 

The rectangle displays on Layer 5, above the sky layer. 

Note Stroke and Fill are not important as long as something is added to Layer 5. 

 4. Keep the image open so it can be used in the next exercise. 

Tip By default, Expression Design adds the new layer immediately above the layer 
that is currently selected. If you prefer the new layer to be added to the beginning of 
the layer list, so that the layer goes immediately to the top of the stacking order, point 
to Options on the Edit menu, and then click General to open the General options 
page. Clear the Create New Layer Above Current Layer check box, and then click OK 
to accept the change. 



Deleting Layers and Changing Layer Order
Not only can you create layers, you can delete them as well. The beauty of layers is that they 

give you the freedom to make many changes to an image without changing the original. 

After you decide on the fi nal design, you can easily delete any unnecessary layers. 

You can also change the stacking order of layers. To move layers up or down in the 

stacking order, drag and drop them into place in the Layers panel. 

In this exercise, you will delete layers and change their stacking order by using the 

Layers panel. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

 1. Select Layer 5, and then in the lower portion of the Layers panel, click the Trash 
button to delete the layer. 

Trash button

The Delete Layer dialog box opens. 

 2. In the Delete Layer dialog box, click Yes to confi rm the deletion. 

  3. In the Layers panel, drag the winter layer to position it above the summer layer 

and below the autumn layer.  

  4. When the yellow line displays, drop the layer into place.  

 The stacking order of the layers changes. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

TrashTrash
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Moving Objects to Another Layer
Often, to keep similar or related objects together, you might want to move them 

to another layer. You can do this by using the Layers panel. Whenever you create a 

new object, Expression Design’s default action is to place it on the layer that is currently 

selected in the Layers panel. When you select any object on the page, the Layers panel 

automatically selects the layer the object is on, as long as the layer is unlocked. To move 

a selected object from one layer to another, expand the source layer in the Layers panel 

so that the object list is visible. Drag the object to another position on the same layer, or 

to another layer. When the yellow line displays under the name, drop the object. 

An object can be copied to another layer by using the Copy command to copy it from 

one layer and the Paste command to paste it to another. This places a copy of the object 

on the new layer while leaving the original on the layer from which it was copied. To re-

move the object from one layer and place it on another, use the Cut command.  

In this exercise, you will move objects to another layer by dragging and dropping in the 

Layers panel and by using the Copy and Cut commands. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.

 1. Make sure the summer layer is visible. Expand the summer layer, and select the 

tree group. 

 2. Expand the sky layer. If you cannot see all of the layers, resize the panel by pulling 

down and dragging the bottom-right corner. 

 3. Drag the tree group to the sky layer, and drop it under the clouds group when the 

yellow line is visible. 

USE the layers.design fi le. This practice fi le is located in the Documents\Microsoft Press\
Expression Design SBS\UnderstandingLayers folder.

OPEN the layers.design fi le, if it is not already open.



The tree group is now on the sky layer, between the sky object and the clouds 
group, and the tree group should be selected. 

Tip If you drag an object to the layer rather than to a position in the object list of 
that layer, it is placed at the bottom of the stacking order in the new layer. 

 4. Click Cut on the Edit menu. Select the summer layer. Click Paste on the Edit menu, 

and the tree group will be moved from the sky layer to the summer layer. 

Using the Cut command removes objects from the layer and places them on the 

layer you paste them onto. 

 5. Collapse the summer layer. Click the Toggle Layer Visibility button to display the 

winter layer, and then expand the layer. Select the derby group. 

 6. On the Edit menu, click Copy. 

 7. Select the sky layer, then click Paste on the Edit menu to paste the derby group onto 

the sky layer. 

 8. Click the Toggle Layer Visibility buttons on the summer and winter layers to hide 

them.  

The derby graphic should be visible in the image window, and if you look at the sky 

layer in the layers panel, the derby group is now above the clouds group.  

 Tip When you paste using the Copy command, the selection is placed in the center 
of the page. To copy the selection to the top of the stack, on the Edit menu, click Paste 
In Front. The selection is copied to the new layer in the same position on the page it 
occupied on the original layer at the top of the stack. To copy the selection to the bot-
tom of the stack, on the Edit menu, click Paste In Back and it will be pasted in the same 
position on the page, but at the bottom of the stack. This is true when pasting to the 
same layer or to another layer. 
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 9. Experiment with these options in the practice fi le, moving any of the groups to 

another layer, cutting, copying, and trying the Paste In Front and Paste In Back 

commands from the previous tip. Make sure the layer you want to copy or move 

to is visible and not locked. 

 Tip Although it would seem to be exactly what you want, the Paste With Layer 
command on the Edit menu will not move the selection to another layer. It places 
the object back on the original layer. 

CLOSE the layers.design fi le without saving your changes. If you are not continuing directly 
to the next chapter, exit Expression Design.

Setting Layer Options
At the bottom of the Layers panel is the Layer Options button, which opens the Layer 

Options menu. On this menu are several options you should be aware of: 

 New Layer. Use this option to create a new layer above the current layer. 

 Duplicate Layer. Use this to create a copy of the layer above the original with copy 

appended to its name. 

 Delete Layer. Use this option to throw the selected layer in the Trash. 

 Layer Color. Use this option to show the color paths when objects are selected on 

the layer. 

 Layer Render Style. Use this sub-menu to access the same options that are available 

in Display Quality on the View menu, with the addition of Path. (See Chapter 2, 

“Navigating the Workspace.”) 

 Thumbnail Options. Use this sub-menu to control the display of thumbnails, as 

discussed in “Understanding Layers” earlier in this chapter. 

CLOSE the layers.design fi le without saving your changes. If you are not continuing directly 
to the next chapter, exit Expression Design.



Key Points
 Layers are like stacks of transparent paper. Where there is content, the layer is 

opaque; where there is no content, the layer is transparent, letting objects on the 

layers below show through. 

 You can rename layers in the Layers panel by double-clicking the layer’s name and 

typing a new name. Press Enter to commit the change. 

 You can use the Toggle Layer Visibility button to show and hide layer content. Hold 

the Alt key as you click the button to toggle visibility for all other layers at once. 

 Hidden layers are always locked and cannot be selected. You can lock or unlock 

visible layers. 

 You can select a layer’s contents by clicking its square layer selection button. 

Remember, you cannot select a locked layer. 

 You can expand and collapse object lists in the Layers panel to make the panel 

easier to scroll through. 

 You can lock layers to protect them from accidental movements or object deletions 

and to protect them against global changes made to the document. 

 You can select hard-to-reach objects by clicking them in the Layers panel object 

list. You can then group or ungroup them by clicking the corresponding command 

on the Arrange menu. 

 You can add new layers by clicking the New Layer button at the bottom of the 

Layers panel. By default, new layers are added above the currently selected layer. 

 You can easily delete layers you no longer need by selecting them and clicking the 

Trash button at the bottom of the Layers panel. 

 You can change the stacking order of layers by dragging them in the Layers panel 

to a new position. 

 You can use the Layer Options menu at the bottom of the Layers panel to create, 

duplicate, and delete layers or set options for layers. 
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Index

A
Acrylic fi les, importing, 18–20
Action Bar

defi ned, 7, 263
Stack list, 28

active document, 14
Adobe Reader, installing, 244
aligning

defi ned, 263
objects, 62, 63
text, 177

alpha channels, 5
alpha transparency, 263
anchor points, 4, 12. See also cusp points

converting to curves or corner points, 96
corner vs. curve, 94
defi ned, 263
deleting, 107
displaying/hiding, 254
moving, 96
nudging precisely, 61
object shape, changing with, 59–61
overview of, 58
Paintbrush tool and, 126
path direction and, 94
selecting, 61

anchoring
objects, 28
strokes, 162–163

anti-aliasing, 232, 263
appending to paths, 126–127
area text, 189–191, 263
arranging objects. See stacking order
artboard

defi ned, 6, 263
sizing, 15, 200

artwork. See images
Auto Save, 43
auto tracing, 199, 263
autosave frequency, setting, 258

B
Back Minus Front command, 117, 118, 263
baseline offset, 263
baseline, text, 173

defi ned, 263
offset of, 182, 188

bitmap effects. See live effects
bitmap images. See also raster images; raster 

programs
center point, manipulating, 218
compressing, 219
converting to vector graphics, 210–217
creating, 205–210
defi ned, 263
exporting vector graphics as, 230–233
overview of, 199
refl ecting, 219
rotating, 218, 220
scaling, 219
skewing, 218–219
stretching, 219
tracing, 210–217, 268
transforming, 218–222

bitmap programs. See raster programs
bitmap strokes, 163–164
Blend Mode, 132, 263
blending paths, 165–169, 263
.bmp images. See bitmap images
bounding boxes, setting crop marks from, 

226, 228–229
brush strokes. See strokes
B-Spline curves, defi ned, 92–93, 263. See also paths
B-Spline tool, 109–110, 263
buttons, 30, 263. See also widgets
Bézier curves. See also paths

control handles, 93
defi ned, 92, 263
drawing freehand. See Paintbrush tool
origin of, 92
segmented, 100–102, 267
tangent lines, 104

Bézier, Pierre, 92
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C
centering objects, 63
character spacing. See tracking, text
chrysanthemums, creating, 164
circles, drawing, 97–98, 265
clipping masks

creating, 120–121
defi ned, 264, 266
overview of, 119
selecting, 119
text as, 119

clones, 154, 157–158
breaking links to, 158
defi ned, 264
of text objects, 158

closed paths, 93
defi ned, 264
drawing with Paintbrush tool, 126
vs. open, 92

closing
documents, 14
panels, 28
text objects, 174
views, 38

CMYK color model, 264
collisions, typographical, 183, 264
color depth in vector graphics, 213
color dropper settings, 251
Color Picker, 130, 134–136, 264
color stops, 141
colors, fi ll. See fi ll colors
combining paths, 117–118
commands

ellipsis (...) after, 9
grayed out, 9
menu, 40

committing transforms by default, 250
Community Technology Preview (CTP) fi les, 

importing, 18–20
compound paths

creating, 115–116
defi ned, 115, 264
releasing, 116

compressing bitmap images, 219
compression

defi ned, 264
lossless vs. lossy, 235

content, 264
context menu, 264
context sensitivity

defi ned, 264
of panels, 30

control handles, 93, 264
controls, image. See widgets

Convert Anchor Point tool, 96, 112, 264
copying

images, 204
layers, 88
objects, 65, 66
objects, between layers, 86–88

corner points, 94 See also anchor points
converting anchor points to, 96
converting to curve points, 96
creating with Pen tool, 104

Creature House Expression, 150
importing, 18–20

crop marks. See also exporting; printing
deleting, 228
ignoring, 232
overview of, 226
redrawing, 228
setting, 226–229

cursor, inserting, 174. See also text; text objects
curve points, 94 See also anchor points

converting corner points to, 96
curves. See paths
cusp points. See also anchor points

creating, 113
defi ned, 111, 264

custom strokes
creating, 159
overview of, 158
saving, 160
vector, 159–161

cutting and pasting. See copying

D
dash properties, setting, 152
decoration, font, 176, 265
deleting, 264

anchor points, 107
crop marks, 228
layers, 85, 88
objects, 65–66

descenders, text, 173, 264
deselecting, 264

objects, 51, 53
Direct Selection tool, 12, 96, 215
Display Quality setting, 264
distributing objects, 62, 64, 264
dividing paths. See splitting paths
docking panels, 29
document frame. See artboard
document units, setting, 53, 255
document window

capturing images from, 205–210
defi ned, 6, 265
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exporting images from, 233–236
fl ip bar. See fl ip bar
rulers in, 6

documents
active, 14
actual size, viewing, 40
bringing to front, 14
closing, 14
creating, 15
custom size, 16
defi ned, 5, 265
fi tting to screen, 40, 42
moving around in, 39–40
naming, 15
navigating, 39–40
open, listing, 14
opening, 8
output types, 15
panning, 39–40, 106
preset sizes, 15
resolution, selecting, 17
reverting to saved version, 43, 267
rotating, 16
rotating viewing area, 34, 38
saving, 44
saving copy of, 44
sizing, 15
switching between, 14
tabs for, 7
thumbnails, 258
unsaved changes, asterisk indicating, 7
with landscape orientation, 16
zooming. See zooming

dots per inch (dpi), 2
dragging

marquees, 51–52, 265
objects, 12

drawing
closed paths, with Paintbrush tool, 126
paths, with Pen tool, 104–105

drawing paths, 94, 99–100, 266
dual monitors, dragging panels between, 29
duplicates, 154
duplicating. See copying

E
editing

objects, 11
paths, 11, 96–97
paths, multiple, 13
rectangles, 96–97

strokes, 160
text objects, 174–175

edits, undoing. See undoing changes
effects, text, 177
Ellipse tool, 97–98, 265
ellipses, drawing, 97–98
ellipsis (...) after commands, 9
encircling selections, 61, 265
endpoints, path, 93, 265
expanding

groups, 82
Layers panel, 77, 79
tool groups, 24

Export dialog box, bypassing, 231
exporting. See also crop marks

images, 230–233
images, from document window, 233–236
images, to PDF, 242–245
images, to XAML code, 236–241

Expression Blend, vii
Expression Design

fi le formats supported by, 5
help with, xix–xx
overview of, vii, 1
preferences. See Options dialog box
starting, 7

Expression Media, vii
Expression Web, vii
extending paths, 126–127
Extensible Application Markup Language (XAML), 

236–241

F
families, font, 176, 178, 265
fi le formats supported by Expression Design, 5
fi le name extensions for vector graphics, 4
fi les. See documents
fi ll colors

changing, 26, 31, 130, 135–136
custom, 137
default, setting to, 95
for text, 176, 180
removing, 135
selecting by, 55
solid, 135

fi ll opacity, 134
fi ll rules, 132–133
fi lls

gradient, 135, 140–146
images as, 135, 138–139
images as, transforming, 250
repositioning, 103–104
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fi tting documents to screen, 40, 42
fl ip bar

defi ned, 265
location of, 7
tabs on, 14

fl ipping bitmap images, 219
Float button, 75
fl oating, 265

panels, 29, 75
fonts

changing, 178
decoration, 265
families, 265
size, setting, 177
styling, 176–177

frame, document. See artboard
Front Minus Back command, 117–118, 265
frozen layer memory limit, 262

G
GIF images, 3 See also bitmap images
glyphs, 265 See also text objects

defi ned, 172
width, setting, 181

gradient fi lls, 135, 140–146
applying, 143
color, changing, 143
shape, changing, 144
speed of, 141, 268
transforming, 142, 145
transparency, setting, 142
transparent, exporting, 242

gradient nodes, 141
adding, 144
defi ned, 265
selecting, 144

graphic programs. See Expression Design; 
raster programs; vector programs

graphics. See images
graphics tablets, 127, 265
grayed out commands, 9
greeked text settings, 254
grid. See page grid
Group Select tool, 57
groups

creating, 56–57
defi ned, 56, 265
expanding, 82
layers and, 80
selecting single objects in, 57
ungrouping, 56

H
handles, 49

displaying, 49, 254
help with book or CD, xix
hiding

layers, 76–77, 103
panels, 28

HLS color model, 266
holes in paths. See compound paths
horizontal alignment, 177, 266
horizontal scale, text, 181, 266
HSB color model, 266

I
illustration programs. See vector programs
image objects

defi ned, 266
manipulating, 205
opening, 200

images. See also raster images; vector graphics
anti–aliasing, 232
as fi lls, 135, 138–139
as fi lls, transforming, 250
as strokes, 163–164
bitmap. See bitmap images
compression, lossy vs. lossless, 235
copying, 204
creating, 94
exporting, 230–233
exporting from document window, 233–236
exporting to PDF, 242–245
importing, 200, 202–203
importing, matching resolution when, 208
opening, 200, 204
pasting, 201–202, 204
pixels in. See pixels
printing, 246–248
reverting to saved version, 69
settings, changing, 7
XAML code, exporting to, 236–241

Import Document dialog box, 18–19
importing

fi les from earlier versions, 18–20
images, 200, 202–203
images, matching resolution when, 208
summaries of, 258

in-between objects, 266
intersecting paths, 117, 119, 266
inverting selection, 53–54
italicizing text, 179



J
JPEG images, 3. See also bitmap images
justifying text, 177

K
keyboard shortcuts

fi nding, 9, 25
for opening documents, 8
for Save A Copy command, 44
for Save As command, 44
for Save command, 44
for selecting all, 32
for Selection tool, 12
for switching documents, 14
for tools, 9
for Undo/Redo commands, 42

L
landscape orientation, 16
Lasso Selection tool, 61, 194
Layer Options button, 88
Layer Selection button, 81
layers

activating, 36, 77
adding, 83–84
color paths, displaying, 88
copying, 88
creating, 88
creating, placing above current layer by 

default, 250
default organization of, 76
defi ned, 266
deleting, 85, 88
freezing, memory limits for, 262
groups and, 80
hiding, 76–77, 103
locking, 80–81, 103, 266
moving objects between, 86–88
naming, 76
overview of, 74
render style, 88
selecting, 80–81
stacking order, changing, 85
thumbnails for, 76, 88

Layers panel, 7, 10–11, 74 See also panels
collapsing/expanding, 77, 79
defi ned, 266
displaying, 75

leading, text, 181, 183, 266
Letter preset, 16
Line tool, 25, 99–100, 266
lines

drawing, 99–100
drawing, with Pen tool, 104–105

live effects
defi ned, 17, 266
rasterizing, 260
resolution and, 17

locking
layers, 80–81, 103, 266
objects, 53, 57

lossless vs. lossy compression, 235, 266

M
magnifi cation. See Zoom tool; zooming
main window. See document window
marquees, dragging, 51–52, 265
masks. See clipping masks
menu commands, 40
messages and warnings, display settings for, 251
Microsoft Acrylic fi les, importing, 18–20
Microsoft Expression Design. See Expression Design
midpoint slider, 266
modes. See views
monitors, dual, dragging panels between, 29
More Information buttons, 30
mouse wheel

default settings, changing, 39
zooming with, 39–40

mouse wheel settings, 250
moving

objects, 12, 27, 31
panels, 29

N
name bar. See fl ip bar
naming

documents, 15
layers, 76

navigating documents, 39–40
New Document dialog box, 15
new documents, 15
New Layer button, 83
nodes. See anchor points
nudging objects, 62, 257, 266
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O
object points. See anchor points
objects

aligning, 62–63
anchoring, 28
attributes, 263
centering, 63
cloning. See clones
copying, 65–66
defi ned, 8, 266
deleting, 65–66
deselecting, 51, 53
distributing, 62, 64, 264
dragging, 12
dragging a marquee around, 51–52
duplicating, 154. See also copying
editing, 11
fi ll colors. See fi ll colors
gradients, applying. See gradient fi lls
grouping. See groups
handles. See handles
inner corners. See cusp points
inverting selection, 53–54
locking, 53, 57
moving, 27, 31
moving to new layers, 86–88
nudging, 62, 266
opacity, changing, 32
positioning, 61–65
red dots surrounding. See anchor points
reshaping, 12
resizing, 32, 68–69
rotating, 69
rotating around specifi c point, 69–70
scaling, 68–69, 166–167
selecting, 11, 48–49
selecting all, 32, 53
selecting multiple, 13
shape, changing, 58–61
squares surrounding. See handles
stacking order. See stacking order
transforming, 66–71
unlocking, 54
width and height, changing, 31–32

opacity
changing, 32, 152
defi ned, 266
of text objects, 176

open paths, 94
defi ned, 266
Start point, changing, 154
vs. closed, 92

opening
documents, 8
images, 200, 204
Options dialog box, 249
panels, 28
Strokes Gallery, 151

Options dialog box, 249
origin point, 10
outlines. See paths
ovals, drawing, 97–98, 265
overlapping paths, 117

P
page frame. See artboard
page grid

defi ned, 102, 265
displaying, 103
size, setting, 256
snapping objects to, 111

paint programs. See raster programs
Paintbrush tool, 126

anchor points and, 126
drawing with, 127–130
pressure trail, displaying, 253
smoothing path of, 253

Pan tool, 39–40
panels. See also Layers panel; Properties panel

closing, 28
context sensitivity of, 30
default position of, 28
docking, 29
dragging to second monitor, 29
fl oating, 29, 75
hiding all, 28
moving, 29
opening, 28
resizing, 29
scroll bars. See scroll bars
widgets in. See widgets

panning documents, 106
pasting images, 201–202, 204
Path view

defi ned, 267
switching to, 36

paths. See also Bézier curves; B-Spline curves; 
vector graphics; vector programs

blending, 165–169
closed, 93, 264
compound. See compound paths
converting anchor points to, 96
converting strokes to, 154, 156–157
converting text to, 192–196
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cutting out of each other, 117–118
defi ned, 92, 267
direction, changing, 94
drawing, 94. See also line tool; shape tools
editing, 11, 96–97
editing multiple, 13
extending, 126–127
intersecting, 117, 119, 266
masking areas with. See clipping masks
open vs. closed, 92
quality, setting, 262
reversing, 153, 155, 267
segmented, 100–102
selecting, 96, 155
simplifying, 126, 268
splitting, 153, 155–156, 261, 268
stacking order. See stacking order
Start point, changing, 153–154, 156
text in, 189–191
text on, 185–189
ungrouping, 215
uniting, 117–118, 268
with holes. See compound paths

PDFs
defi ned, 267
exporting images to, 242–245

Pen tool, 104–108
petals, repeating, 164
photographs. See images; raster images
pinning. See docking panels
Pixel Preview

overview of, 34
settings, changing, 36
turning off, 37
turning on, 35

pixels. See also raster images; raster programs
defi ned, 2, 267
print size and, 2

pixilation, 2, 267
placement grid. See page grid
Polygon tool, 98–99, 267
Polyline tool, 100–102, 267
positioning objects, 61–65
preferences, 249
preset sizes, 15

Letter, 16
pressure scale, setting, 253
pressure trail, displaying, 253
Preview view

defi ned, 267
switching to, 35

printable area, displaying, 255
printing. See also crop marks

images, 246–248
resolution and, 17, 247

Properties panel, 7, 10–11. See also panels
categories, collapsing, 132
components of, 130
defi ned, 267

protecting. See locking
PSD fi les, 5

Q
quick select option, 250

R
raster images. See also bitmap images

defi ned, 3, 267
overview of, 2
vs. vector images, 4
with vector images, 4
zooming in on, 2

raster programs. See also raster images
defi ned, 267
examples of, 3
function of, 2
vs. vector programs, 2

rasterizing, 17, 36, 199, 241, 260, 267
Rectangle tool, 25, 94–97

defi ned, 267
straight lines, constraining to, 95

rectangles
creating, 25
editing, 96–97

Redo command, 42, 267
reference point, 69, 267
refl ecting bitmap images, 219, 221–222
Registration Point button, 69, 267
releasing compound paths, 116
removing. See deleting
repeating

commands, 70–71
petals, 164
strokes, 161

rescue fi les, 43
reshaping objects, 12
resize handles. See handles
resizing

objects, 32, 68–69
panels, 29

resolution
live effects and, 17
matching when importing, 208
printing and, 17, 247
selecting for new documents, 17

reversing changes. See undoing changes
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reversing paths, 153, 155, 267
reverting documents to saved version, 43, 267
RGB color model, 267
rotating

bitmap images, 218, 220
constraining angle when, 256
documents, 16
objects, 69
objects, around specifi c point, 69–70
viewing area, 34, 38

rounding corners on squares, 96–97
rulers, 6

determining position with, 9
settings, 256

S
saving documents, 44

as copy, 44
automatically, setting frequency of, 258

scaling
bitmap images, 219
objects, 166–167, 267
text objects, 172
vector graphics, 4

scaling objects, 68–69
Scissors tool, 153, 155, 267
scroll bars

defi ned, 31, 268
navigating with, 31, 39

scroll wheel. See mouse wheel
scrolling the page, 106
segments, 268
Select By, 55
Select menu, 53
selecting, 268

anchor points, 61
by criteria, 53–56
clipping masks, 119
gradient nodes, 144
layers, 80–81
objects, 11, 48–49
objects low in stacking order, 81
objects, all, 32, 53
objects, multiple, 13
paths, 96, 155
quickly, 250
single objects in groups, 57
text, 179
text objects, 172, 183
tools, 25

Selection tool, 11, 42, 48–49
keyboard shortcut for, 12

shape tools, 95. See also Ellipse tool; Line tool; 
Polygon tool; Rectangle tool

straight lines, constraining to, 95
shapes. See paths
simplifying paths, 126, 268
sizing artboards, documents, 15
skeletal strokes. See strokes
skewing, 268

bitmap images, 218–219, 221
text objects, 172

sliders, 30. See also widgets
defi ned, 268
moving objects with, 31
opacity, changing with, 32
width and height, changing with, 31–32

smoothing bitmaps for vector graphic 
conversion, 213

Snap to Grid option, enabling, 111
spacing characters. See tracking, text
splitting paths, 117, 119, 153, 155–156, 261, 268
squares, rounding corners of, 96–97
stack gap, 257
Stack list, 28
stacking order, 27–28

defi ned, 268
of layers, changing, 85

stars, drawing, 98–99, 267
start point

changing, 153–154, 156
defi ned, 268

Start Point tool, 154
starting Expression Design, 7
Stop Alpha slider, 142, 268
straight lines. See lines
stretching bitmap images, 219
stroke colors

changing, 130, 135–136
removing, 135, 137
selecting by, 56
setting, 150

stroke defi nition box, 159
Stroke Defi nition box, 268
strokes

anchoring, 162–163
applying, 32–33, 151
bitmap, 163–164
converting to paths, 154, 156–157
custom. See custom strokes
dash properties, setting, 152
default, 151
editing, 160
for text, 176
gradient, 135
images as, 163–164
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opacity, setting, 152
options, setting, 151
overview of, 150
repeating, 161
reversing direction of, 94, 153, 155
settings, 252
units of measurement, 256
width, adjusting, 151

Strokes Gallery, 150
opening, 151

styling text, 175–177
sub-paths. See compound paths
subscripts, superscripts, 182, 268

T
tablets, 127
text

aligning, 177
and path fl ow direction, 188
as clipping mask, 119
baseline, 173, 188
collisions, 183
converting to paths, 192–196
descenders, 173, 264
editing, 174–175
entering, 174
fi ll color, 176, 180
horizontal scale, 181
in paths, 189–191
italicizing, 179
justifying, 177
leading, 181, 183
on paths, 185–189
selecting, 179
subscripts and superscripts, 182
tracking, 181, 184, 268

text objects
as paths, breaking apart, 193
attributes, viewing, 178
cloning, 158
closing, 174
defi ned, 172, 268
editing, 174–175
effects, adding, 177
objects, 172
opacity, 176
scaling, 172
selecting, 172, 183
skewing, 172
stroke style, 176
style attributes, 175–176

Text tool, 173, 183
theme settings, 251

thumbnails, document, 258
thumbnails, layer, 76, 88
TIFF images, 3, 5 See also bitmap images

layering in, 5
tilting. See skewing
tool groups, 7

defi ned, 268
expanding, 24, 95

Toolbox
controls in. See widgets
defi ned, 7, 268
layout, 24
widgets. See widgets

tools. See also specifi c tools
keyboard shortcuts for, 9, 25
selecting, 25

tracing bitmap images, 210–217
tracking, text, 181, 184, 268
transforming

auto-committing, 250
bitmap images, 218–222
fi lls, 103–104
gradient fi lls, 142, 145
images in fi lls, 250
objects, 66–71
resetting, 219, 222
text objects, 172
undoing, 167

transparency
displaying, 254
of gradient fi lls, setting, 142
of strokes, changing, 152

trashing. See deleting
triangles, drawing, 98–99, 267
two monitors, dragging panels between, 29
type size, 177, 268
type units, 256
typographical characters. See glyphs; text objects
typographical collisions, 183, 264

U
Undo command, 42
undoing changes, 42–43, 268

in transforms, 167, 219, 222
levels for, setting, 262
number of steps saved for, changing, 42

ungrouping paths, 215, 268
uniting paths, 117–118, 268
units of measurement, 10, 16, 53, 255–256
unlocking

layers, 80, 268
objects, 53–54

user interface options, 251–252
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V
vector graphics. See also paths

color depth, 213
converting bitmap images to, 210–217
defi ned, 268
exporting as bitmap images, 230–233
fi le name extensions, 4
function of, 4
paths. See paths
scaling, 4
vs. raster graphics, 4
with raster images, 4

vector objects. See paths
vector programs

defi ned, 268
examples of, 4
vs. raster programs, 2

vector strokes, 159–161
vectors, anchor points/paths in, 4
viewing area, rotating, 34 38
views. See also Path view; Preview view; 

Wireframe view
closing, 38
creating, 34, 37
overview of, 34

W
warnings and messages, display settings for, 251
widgets. See also buttons; sliders

defi ned, 7, 30, 268
window, document. See document window
Wireframe view

defi ned, 268
switching to, 35

workspace
components of, 5
defi ned, 5, 268
resetting, 7
zoom level, setting, 252

X
XAML (Extensible Application Markup Language)

defi ned, 268
exporting images to, 236–241

x-coordinate, 10
XPR fi les, 18–20

Y
y-coordinate, 10

Z
0 point, 10
Z-axis rotation settings, 253
Zoom tool, 41
zooming, 40–42, 105

setting default level of, 252
with mouse wheel, 39–40
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